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Benefits and Features

Transfer data stored in 
Ultrameter II™, Ultrameter III™, 
PoolPro™ and Digital Dialysate 
Meter™† handheld instruments to 
U2CI application via Bluetooth*** 
wireless technology

Reduce Data logging errors

Reduce Data logging time

Share saved water sample data

Lose the clipboard and still easily 
comply with record-keeping 
requirements

bluDock Accessory Package 
Includes: 
bluDock™, U2CI Software CD, 
Operation Manual, Quick Start 
Installation Guide and dongle for 
downloading data to Mac or PC 
platforms that do not have built-in 
Bluetooth® capabilities. 

Product highlights
• 	Transfer data wirelessly with 

accuracy, reliability and 
simplicity.

• 	Easy to install software from CD 
or website: http://myronl.com/
main/U2CI_Application_DL.htm

• 	The U2CI™ application will 
operate on Windows XP, Vista 
and 7*; and Macintosh OSX**. 
If you are running an older 
operating system, contact the 
Myron L Company. 

• 	Exports to Office software 
(Word*, Excel*, Works*, etc.) 
using universal formatting 
(.csv) files.

• 	Automatic organization of 
data (record number, type 
of measurement, value and 
instrument measurement, 
solution type, temperature, 
date and time stamp) 

• 	Associate all data from a 
particular instrument by 
assigning a instrument name.

• 	Control instrument time and date.
• 	Clear instrument memory.
For further information, please 
contact the Myron L Company 
(see back cover).

NOTE: The bluDock module is a registered 
Bluetooth*** device.

 * ™Microsoft ** ™Macintosh *** ®Bluetooth SIG

†WARNING:  Digital Dialysate Meter 
measurement data transferred 
to a personal computer using the 
wireless communication option 
is for record-keeping purposes 
only and is not intended for use 
in making treatment or diagnostic 
decisions.

bluDock   EnabledTM



Limited Warranty
All Myron L bluDocks have a Two Year Limited Warranty. Warranty is 
limited to the repair or replacement of the bluDock only, at our discre-
tion. The Myron L Company assumes no other responsibility or liability.
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PLEASE NOTE: 
Because of our commitment to product improvement, the substance 
and style of this manual may change. When changes are made, 
the updated manual is posted for download in PDF format from the 
Myron L Website: www.myronl.com
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system Requirements
Computer running on Microsoft® Windows XP™, Windows 
Vista™ and Windows 7™. For Macintosh® OSX operating 
systems, contact the Myron L Company. 

WARNING:  USERS THAT HAVE PREVIOUSLY INSTALLED 
1.x.x U2CI™ MUST UNINSTALL IT PRIOR TO INSTALLING 
U2CI REV 2.x.x.**

Before installing the new U2CI 2.x.x, Windows users must open the 
“Start” menu, select “Control Panel”, then select “Add or Remove 
Programs”. Scroll to “U2CI”; select it and click on “Remove”. No 
System Reboot is required. 

Mac OSX users should select “Go” in the Finder menu bar, select 
“Applications”, and then scroll down to the U2CI folder. Drag the folder 
to the trash.

**Very IMPORTANT — If you are unsure of how to uninstall and 
install programs on your machine, contact your IT Department or 
System Administrator for assistance.

NOTE: If you have a uDock™, U2CI software versions 2.0.3+ are 
backward compatible. However, the instrument name feature is 
inoperable. 
64-BIT VISTA/WINDOWS 7 USERS: After installing on a Vista 
machine, some users may need to right click the U2CI icon and select 
“Properties”, then select “Compatibility”, and then check the box under 
“Compatibility Mode” to run this program in Compatibility mode for 
Windows XP™ (Service Pack 2/3).

Installation and use of U2CI Rev 2.x.x requires user acceptance 
of the End User License Agreement (EULA). A copy of the EULA 
is on the software CD and can be downloaded from the Myron L 
website: 
http://myronl.com/main/U2CI_Application_DL.htm

special notes
The bluDock module is a registered Bluetooth® device.

Bluetooth is a registered trademark of Bluetooth SIG.
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Example screenshots are of Windows XP and Mac 
OS 10.4.11 Operating Systems. The appearance of the 
installation dialog boxes will vary according to the 
operating system you are on.

Save all work and exit all applications prior to 
installation of this software.

I.	U 2CI Installation 

A.	U 2CI Installation for Windows Users
install u2ci software before pairing the 
bluDock™ with your PC. (Review warning on page 1 
before starting install.)

U2CI Executable and Support Files Installation:

1.	 Insert U2CI software CD into CD drive or download the 
U2CI Application & Documents software package for 
Windows from the Myron L website Download Center: 
http://myronl.com/main/U2CI_Application_DL.htm.
If Auto Install does not start, go to Start\ My Computer\
U2CI and double click on the U2CI icon under Devices 
with Removable Storage. Or you can right click the U2CI 
icon, select “Open” and double click on U2CI.MSI. 

2.	 Click “Next” in the U2CI Setup Wizard Welcome dialog box  
to begin U2CI software installation.



3.	 Close all other 
programs and 
applications. 
Then click 
“Next”.

4.	 Read the  
EULA. If you  
do not agree  
to the terms  
of the EULA,  
click “Cancel”  
and exit the  
installation.  
If you agree  
to the EULA,  
check the  
“I accept  
the terms  
in the license  
agreement”  
box. Then  
click “Next”.

5.	 Click “Install”  
in the “Ready  
to Install”  
dialog box.
A status bar  
will display  
indicating the  
installation  
progress.

3
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6.	 Click  
“Finish”  
in the 
“Completing  
the U2CI  
Setup  
Wizard”  
dialog  
box  
when 
installation  
is complete.



B.	U 2CI Installation for Macintosh OS X Users 
note:  StuffIt Expander may be required. If you do 
not have it, you can download it for free from the web: 
http://my.smithmicro.com/mac/stuffitexpander/
download.html
Install u2ci software before pairing the 
bluDock™ with your Mac. (Review warning on page 1 
before starting install.)

U2CI Executable and Support Files Installation:

1.	 Insert U2CI software CD into CD drive or download the 
U2CI Application & Documents software package for 
Macintosh OS X from the Myron L website Download 
Center: 
http://myronl.com/main/U2CI_Application_DL.htm

2.	 Double-click on the U2CI CD icon then 
double-click the U2CI For Mac OS X 
executable icon on the U2CI CD.

3.	 Click “Agree” 
on the EULA 
dialog box.

4.	 Double-click 
the U2CI 
OSX.app 
icon.
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5.	 Click “Continue” 
on the “Welcome 
to the Mac U2CI 
Installer” screen.

6.	 Read the EULA. If 
you do not agree 
to the EULA, you 
cannot install the 
software. Click 
“Print” or “Save” 
to print or save a 
copy of the EULA 
for your records. 

7.	 Click “Install” on 
the EULA screen.

8.	 Then click “Agree” 
in the License 
Agreement dialog 
box to continue.

9.	 Click “Quit” to 
complete software 
installation 
process. 

Close the U2CI 
Mac OSX 
window.
The software 
has been copied 
to a U2CI 
folder under 
Applications.

6
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II.	Enabling Data Transfer
A.	S etup Hardware

1.	 For a computer without Bluetooth® capability:
	 If you don’t have the dongle that came with the BLUDOCK, one 

can be ordered from the Myron L Company. Order Model # BDDO.
	 Plug in your dongle and install per manufacturer’s instructions.

2.	 For computers with Bluetooth capability/computers with 
Bluetooth dongle installed:

	 First time use of the bluDock:

a.	 Press any parameter button to turn the instrument on.

b.	 Put the instrument in “PC On” mode by 
	 pressing the key until “PC OFF” 
	 is displayed.
c.	 Then press the key.

	 NOTE: “PC Ini” may momentarily be
	 displayed while initializing.
	 “PC On” will be displayed.

d.	 Add bluDock to your Bluetooth devices 
per your operating system procedure.

	 The bluDock device passkey is 1234.

e.	 After pairing, note the number of the port assigned by the 
computer. 

	 NOTE: Windows XP will assign outgoing and incoming 
ports. Note the number of the outgoing port.

NOTE: The instrument will automatically power down after 60 seconds. 
If the instrument powers down during pairing, repeat step 2.

B.	 Launch the U2CI Software
If you are on Windows, double-click on the U2CI icon on the 
desktop, in the Start menu or under Start\All Programs\U2CI.
U2CI executable and program files are located in  
C:\Program Files\U2CI.
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If you are on Mac OSX, select Go from the Finder menu bar. 
Click on Applications. Scroll down to the U2CI folder. Open the 
folder and double-click on “U2CI-OSX-V2.x.x-release”. 

Drag the U2CI-OSX-V2.x.x-release icon to the system dock 
to create a shortcut on the dock or right-click on the file and 
select “Make an Alias” to create a shortcut on the desktop.

C. 	Select Port Preference

1.	 Open the Edit drop-down menu and select “Preferences”.

2.	 In the Port section of your 
Preferences window, select  
the port assigned to the bluDock 
during operating system Bluetooth 
device pairing. The dropdown menu 
displays COM ports 1-100, None and Demo. None is selected 
by default when no instrument is paired. Demo allows you to 
explore the functionality of the U2CI application with a demo file. 
If you can’t send 
commands to the 
instrument after 
selecting the COM 
port, make sure 
the instrument is in 
“PC On” mode. If 
you still can’t send 
commands to the instrument, make sure the instrument is 
paired with your computer. Check your port assignment in your 
operating system’s Bluetooth device manager. Re-open the 
application. Go to Edit, select Preferences, and then select the 
port assigned to the bluDock.

3.	 Click “Save”.

4.	 Put the instrument in “PC On” mode. (See section II.A.2.a-c.)
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You may NOW use the icon buttons or the “UMII Commands” 
drop down menu to send commands to the instrument. (See 
Section III.C. UMII Commands.)

Icon Command

 Download Data

 Set Date and Time

 Erase Memory

 Disconnect
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III: U2CI Menu Summary
NOTE: Functionality is the same for Windows 
and Mac operating systems. Screenshots are of 
Windows XP™. 
The U2CI main menu includes the following  
drop-down menus: File, Edit, UMII Commands and Help. 
This part describes each menu and its submenus’ 
functions in detail.

A.	F ile

1.	 Load (Ctrl / + L) 
This will “load” a 
data file in the 
main window 
screen. If the user 
chooses this 
submenu, the 
standard open file 
dialog will be 
displayed.
The file types 
supported by the 
U2CI are .mlc and .csv formats. If the user chooses the “Open” 
button, the corresponding data file will be loaded into the U2CI 
main window. If the user chooses the “Cancel” button, the 
open dialog will be closed and no file will be loaded. 
If a loading error occurs (for example, wrong data file type or 
damaged data file), the U2CI will display the following warning 
message.

After loading the data file, the corresponding filename will 
be displayed on the right-top corner above the reference 
information field, and the reference information (if there is any) 
will be displayed in the reference information field.



If the user chooses to load a data file and the current data has 
not been saved, the U2CI will display a warning message.
If the user 
chooses 
the “Save” 
button, 
then the 
standard 
“Save As” 
dialog 
box will be 
displayed. 
This is the 
same as 
the “Save” 
dialog box 
on Mac 
OSX.
If the user 
chooses the 
“Don’t Save” 
button, the 
current data will not be saved and the standard open file dialog 
will be displayed. The selected file will replace the current data 
in the U2CI main window screen. 
If the user chooses the “Cancel” button, the loading operation 
will not be executed and the current data will not be changed.

2.	 Clear Data (Ctrl / + D) 
This will clear the current data in the main window screen as 
well as its reference information and file name. When there is 
no data on the screen, this submenu will be grayed out.
If the user selects “Clear Data”, a message will be displayed 
asking you to confirm your decision.
If the user chooses the 
“OK” button, the U2CI 
will check if the current 
data is saved or not. If it 
is not saved, the U2CI will 
prompt the user to save 
the data before clearing it.

11
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3.	S ave (Ctrl / + S) 
On the File menu, click “Save”. This will save the data in .mlc 
format, i.e., the truncated data that is displayed in the U2CI 
main window screen and on the instrument’s display.
MLC data format is used by the Myron L Company’s U2CI 	
application software. Saving your data in a .mlc format enables 	
you to load the data file back into the U2CI software at a later 	
date.

4.	S ave As 
On the File 
menu, click 
“Save As”.
In Windows 
a dialog box 
will provide 
you with a 
choice to 
save the 
data in either 
.mlc format 
or in .csv 
format. If the .csv format is chosen, then the data will be saved 
as the scientific data format without truncating any data. CSV 
(comma separated values) data format can be read by many 
spreadsheet programs, e.g., Microsoft Excel™. In Mac OSX 
this function is the same as “Save”. 
Important Information about Data Format for Spreadsheet 
Applications:
Note:  When importing your .csv formatted data into Microsoft 
Excel™, the reading values will default to a scientific format. To 
view in “Number” format, you must:
a.	 Select the cells containing the reading values.

b.	 Click on the Format pull-down menu.

c.	 Select “Cells”.

d.	 Under the Number tab, select “Number” from the 
“Category:” populated list.

e.	 Click “OK”.



5.	 Print (Ctrl / + P) 
This submenu will 
be active only 
when there is data 
displayed in the 
main window 
screen. When the 
user chooses to 
print the data, a  
standard Page 
Setup dialog will be 
displayed.
The user can 
set up the page 
according to his 
or her needs. We 
recommend using 
the landscape  
orientation. Then 
click the “OK” 
button. 
A standard Print 
dialog will be  
displayed. If the 
user chooses 
“Print”, the 
corresponding 
data list as well 
as the reference 
information and  
the file name will  
be printed  
out.

6.	Q uit (Ctrl / + Q) 
This will quit the U2CI application, the same as closing the 
U2CI main window. If there is any unsaved data in the main 
window screen, the user will be prompted to save the data.

13
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B.	E dit

1.	 Preferences (Ctrl / 
+ R) 

When the user 
chooses this 
submenu, the 
preference window 
will be displayed: 

a.	 “Temp Scale” – 
Choose whether you want to display the temperature in 
Celsius or Fahrenheit.

b.	 “Sort” – Choose how you want to arrange and display the 
data. You can choose to sort by “Record”, “Date”, “Time”, 
“Measurement”, “Solution”, “Temperature”, “Value”, or “Unit”.
“Asc” or “Desc” – Choose whether you want to arrange 
the data in ascending order or in descending order. For 
example: You can choose to sort the data by “Date” in 
descending order and the data will be displayed by date 
with the most recent date at the top.

c.	 “Port” – Choose the communication port assigned to your 
bluDock during device pairing. None, Demo and ports 
1-100 are displayed. If you choose “None” in the preference 
window, the U2CI will display the following message:

Windows XP™ Tip: Instrument must be in “PC On” 
mode to view com port assignment in Bluetooth 
device manager. Open Start\Control Panel\Bluetooth 
devices and click on the Com Ports tab to see which 
outgoing port has been assigned to the bluDock.
The U2CI also provides a “Demo” mode in the port list to 
demonstrate how the U2CI works when the bluDock is not 
connected.

Preferences are displayed below all data along the bottom of the 
U2CI application window.



There are three buttons on the preference window in the U2CI, 
which are: Use Defaults, Save and Cancel.
d.	 The “Use Defaults” button will re-set the preferences to the 

original values during installation.

e.	 The “Save” button will save the preference information that 
the user has selected and apply the current preference 
information to the data on screen.

f.	 The “Cancel” button will cancel the operation. If this button 
is selected, the preference window will disappear, and the 
current display will not be changed.

2.	R eference Info (Ctrl / + I)
When there is no data displayed in the main window screen, 
both the Reference Info submenu and the Reference 
Information field will be grayed out. They are activated only 
when there is data displayed on the screen. When you 
load a data file, the filename appears above the Reference 
Information field. The user can then edit and modify the 
corresponding reference information.
When the user chooses the Reference Info submenu, the “OK” 
button will be visible under the reference information field. 
After editing the reference information, you must click “OK” 
to save any edits and exit the field. The maximum number of 
characters allowed in the reference information field is 100.

3.	A ssign Name
You can assign a name to an instrument so that the instrument 
name is always associated with data downloaded from that 
instrument. The instrument name is saved in the data files.
Select Assign Name from the Edit menu. The cursor will 
appear in the Instrument Name field above the Reference 
Information field in the U2CI application window. The “OK” 
button will be visible next to the Instrument Name field. Click 
“OK” to save any edits and exit the field. The maximum 
number of characters is 8. The instrument name is also stored 
in the instrument’s firmware.

15
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C.	U MII Commands

1.	D ownload Data
Click the Download Data icon or select “Download Data” from 
the UMII Commands drop-down menu to download data from 
the instrument to your computer. 
The U2CI will display a 
message box.
Click “OK”. 
Note: The instrument will 
shut itself off automatically 
after 60 seconds of inactivity. 
If it has powered down 
before you start to download new data, a prompt will tell you 
there is no response from the instrument. The same prompt 
appears if the instrument is not synced with the system. Ensure 
the instrument is in “PC On” mode and properly paired with 
your system. (See II. Enabling Data Transfer, pg. 7.)
If you have previously downloaded data in the same session, a 
prompt will appear asking whether or not you want to save the 
current data before downloading new data. Click “Save”. 

Download Data
Set Date and Time

Erase Memory
Disconnect

Reference Information
Unit Name

UMII Commands: You may use the icon buttons (shown above) or the 
UMII Commands drop down menu to send commands to the instrument.
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If the bluDock is properly connected and the instrument is in 
“PC On” mode, the U2CI will begin to download data from the 
instrument. 
The download 
progress bar will 
appear while 
downloading.
If your bluDock is not properly connected or your instrument 
is not in “PC On” mode, the U2CI will display a warning 
message.

In the event that the transmission is interrupted or the data set 
is not completed within the timeout period, e.g., the bluDock 
signal is blocked or moves out of range during transmission, 
the instrument is not 
properly paired,  
or the instrument is 
not synced with the 
system, the U2CI  
will display a 
message indicating  
there was no  
response from  
the instrument.
If there is a problem and the download process cannot be 
started within the instrument’s automatic timeout period, the 
U2CI will display a message indicating there is no response 
from the instrument. In this case, put your instrument back into 
“PC On” mode and try again.
The U2CI will also protect the unsaved data in the main window 
screen by displaying a warning message when the user tries to 
download new data from the instrument.
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2.	S et Date and Time
This will set the date and time on your instrument. If the 
bluDock is properly connected and the instrument is in “PC 
On” mode, the Date and Time status bar will be displayed. 
Please note: The date and time is taken directly from your 
computer. To ensure accuracy, verify that your computer’s Date 
and Time are correct.

3.	E rase Memory
This will erase 
the data 
stored in the 
instrument’s 
memory. If 
the bluDock 
is properly 
connected 
and the instrument is in “PC On” mode, a dialog box will 
prompt you to confirm your decision to erase data stored in the 
instrument’s memory.

4.	D isconnect
This will close the communication port between the U2CI and 
the instrument. We recommend that you disconnect after each 
session to ensure that the com port is closed.

A message will display indicating the corresponding 
communication port that will be closed.
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D.	H elp

1.	U 2CI Info
When the user chooses this submenu, the version, build date, 
etc., will be displayed in the U2CI Information dialog box.

2.	 Myron L Company
When this submenu is clicked, it will link the user to the 
Myron L Company website (if an Internet connection is 
available):  http://www.myronl.com/
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IV.	D ata Displayed
The loaded or downloaded instrument data is displayed below the UMII 
Commands icons and the Reference Information field. All information 
recorded with the measurement is displayed.

A.	R ecord #
The record number is the measurement data position in the 
instrument’s memory. You can overwrite a location in memory, so 
the record number is not necessarily chronological in order.

B.	 Measurement
The measurement indicates the parameter measured, such as 
conductivity, resistivity, TDS (MIN/SALT displays as TDS), pH, ORP, 
free chlorine, alkalinity, hardness, or LSI. Because temperature is 
recorded with each measurement, it is not reported here.

C.	 Value
The value is the measured numerical value of the reading.

D.	U nits
The units column indicates the units of measure of the measured 
numerical value.

E.	S olution
For conductivity, resistivity, mineral/salt and TDS measurements, 
the solution is the solution mode the measurement was made 
in, which determines the temperature compensation and TDS 
conversion algorithms used by the instrument. 
For free chlorine measurements, the solution field contains 
information used by the instrument in the ORP mV to ppm free 
chlorine conversion: the ORP mV value at equilibrium and the 
measured solution pH.
For LSI measurements, the solution field indicates whether the 
value is a hypothetical value calculated in the LSI Calculator 
function or a measured value as determined by the LSI titration 
function. For the LSI Calculator value, USER displays along with 
the alkalinity, hardness and pH values used in the calculation. For 
the LSI titration value, the alkalinity titration value, hardness titration 
value, and pH measured value used to compute LSI display.

F.	T emperature
The temp. is the temperature of the solution, recorded at the same 
time the measurement was made.
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G.	D ate
This is the date the measurement was made. The date is displayed 
in the format yyyy-mm-dd.

H.	T ime
This is the time of day the measurement was made. The time is 
displayed in the format hh:mm:ss.

V.	Other Features in U2CI
A.	A pplication Window Options

The U2CI main window can be minimized, maximized or resized 
according to the user’s needs.

B.	A ctive Menus and Fields
When no data is loaded in the U2CI application window, the 
following menus and fields will be grayed out:
•	 Clear Data
•	 Save
•	 Save As
•	 Print
•	 Reference Information
They will be activated only when there is data displayed in the 
main window screen.

C.	 Windows .mlc File Association
The U2CI supported data file (.mlc) format can be opened by the 
U2CI automatically. To have the U2CI open the .mlc file, you must 
first associate the .mlc file with the U2CI program. To do this, 
double-click the .mlc file. 
A dialog box will prompt you to locate the program that created the 
file. Select “Select the program from a list” and click “OK”.
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In the next window that will be displayed, check “Always use the 
selected program to open this kind of file. Then click “Browse…” 
Select the U2CI program and click “Open”. If you chose the default 
location for the software during installation, it is in C:\Program 
Files\Myron L Company\U2CI\U2CI-WIN-v2.x.x-release.exe.

If the user tries to open a non-supported data file or a damaged 
data file with the U2CI, then the U2CI application will give a 
warning message.

D.	U 2CI supports tooltips
When you move the mouse over a UMII command icon or the 
Reference Information field, a tooltip with descriptive text will 
display.
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VI.	T roubleshooting

Symptom Solution

No Device Detected 1.Verify your preference setting is set to 
the correct port. 

2.Verify the instrument is in “PC On” 
mode.

Preference settings 
don’t save

Vista users update to Service Pack 2 or 
run in compatibility mode.

Error: 1 Can’t Read 
Port File

Setup files are corrupted. Reinstall U2CI 
application software.

Error: 2 Couldn’t 
Open Com port

Unplug dongle, if applicable, and ensure 
correct COM port is selected.

Error: 3 No 
Response from the 
Instrument

Verify the instrument is in “PC On” mode 
then try download again.
Device not synced with computer. Try 
waiting 20 seconds while in “PC On” 
mode to sync or re-pair device with 
computer.

Error: 4 Broken 
Communication

Ensure instrument is in “PC On” mode 
then try download again.

Error: 6 Can’t Clear 
File

Call Myron L Company for technical 
support.

Error: 11 Can’t Read 
name File

Name file corrupted. Reinstall U2CI 
application software.

Error: 12 Can’t Set 
time Successfully

Ensure instrument is in “PC On” mode 
then retry Set time.

Error: 13 Can’t Set 
date Successfully

Ensure instrument is in “PC On” mode 
then retry Set date.



VII.	N otes

24
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